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Introducing Details

Overview

In Details, you create and edit course, teacher, student, and resource
information. All other modules draw this information from Details.

The data you enter in Details is used to track information about courses,
teachers, students, and resources in other modules such as Report Cards and
Scheduler.

General procedures for using Details are provided in “Using the Details
Module” on page 3.

Procedures for entering and processing details on courses, teachers,
students, and resources are in the following sections. You can also generate
and print reports on any of the information.

Entering Course Details page 21
Entering Teacher Details page 37
Entering Student Details page 45
Entering Resources Details page 60
Working With Reports page 63

Getting Technical Support

Chancery’s support programs are available by subscription and include the
below services.

Technical Support solves problems and answers questions when
software doesn’t produce the expected results.

Monday to Friday, 5 am to 5 pm Pacific Time
phone: 1-800-688-9939

fax: 1-800-346-0643

email: techsupp@chancery.com

website: http://support.chancery.com

Web support Chancery’s website includes a searchable
knowledge base with frequently asked questions,
tips, and troubleshooting, as well as support
forums for users to share experience and
knowledge. Web tutorials are available on an
annual subscription basis.

Introducing Details e Overview 1
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Software updates releases of new versions with improved functions
and software fixes. Updates are provided free of
charge for 3 months from your date of purchase
and are included in the subscription to Chancery
Support Programs.

For more information on Technical Support Programs, call Chancery
Customer Service at 1-800-999-9931 extension 130.

Providing Feedback

To improve the quality of your documentation, we would like your
comments regarding this guide. Email comments to Chancery’s User
Education department at user_docs @chancery.com.

2 Introducing Details e Providing Feedback
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Using the Details Module

Setting Up Details

We strongly recommend you close other applications while using
Win School.

Before using Details, use School Setup to set up structures for data entry in
Details. Codes, lists, fields, flags, Custom tabs, and Multi-Data tabs
information are created and modified in School Setup for use in Details.

If you find a popup menu in Details with no items listed, you have not
created a list in School Setup. The same applies to unlabelled fields and
flags. Close Details, open School Setup, and add information.

Using the Details Module

The Details module has 4 parts used to create, edit, and delete records:

Course Details
Teacher Details
Student Details

Resources Details

Details manages information for 2 purposes:

record-keeping and calculation in Attendance, Report Cards, or
Scheduler

displaying in Query or reports

Running Details with Other Modules

Some restrictions apply to using Details when more than 1 module is
running at the same time.

With any other module, you cannot start Course Details or Teacher
Details.

With School Setup, you have view-only access to all dialogs except the
Edit Points & Credits dialog for Report Cards.

With Scheduler, you have view-only access to teachers and courses.
Scheduler cannot be run if teachers or courses are open in Details.

Changes you make in Details appear in other modules and for other
users shortly after you save those changes.

Using the Details Module e Setting Up Details 3
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Running Details in Multi-User Mode

With Win School multi-user, many users can use Details at the same time,
if they edit different records. The last person to save the data has their
changes saved.

Only 1 user at a time can edit status codes, conduct codes and student
comments. View-only access to this data is indicated by a padlock beside
the field. When the user with edit access closes that dialog, the data
updates, the lock disappears, and the computer beeps.

Using the Main Window

There are 4 view icons at the top of the Main window in Details: Courses,
Teachers, Students, and Resources. These icons are dimmed and inactive if
you do not have password access to that information.

N -~ [ =] 51]

File Edit Details Beports Help

A<M R

Courges Teachers Students || Resources

| All Students | Student Subset |

Homeroom Mormal Grade Selected
Mumber Student Hame Mumber  Program Level 0]
[ T — [ T I T | e | o | é‘
1 A wae | 107 A Tmic [l
2 Alexander, Richard Darren o 100 Academic | 12 [l
4 Allzop, Blair Alexander o 107 Academic | 11 [l
5 Ay Suman Frances e N Aeadaowe | 1T [l
B Anstey, Jennifer M argaret 2 106 Academic | 12 [l
7 Azimaow, |saac Bemard o 104 Advanc.. |12 1 ﬂ

e To see a view, click the view icon or use the key combination Ctrl-F1
to Ctrl-F4 for Courses to Resources respectively.

e To create a record from the Main window, make sure you are in the
right view, then choose New from the File menu.

e To open the record for an item in the Main window, double-click it.

e To change the information in a column with VCR buttons, click the
chevron and select what you want to see.

e Inactive students are displayed in italics.

You can hide inactive students by choosing Hide Inactive Students
from the Edit menu.

4 Using the Details Module e Using the Details Module
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Using Tabs

In Details, you enter or edit data in tabs.

Custom tabs Multi-Data tab
defined in School Setup defined in School Setup

Enroliment tab

Allsop, Susan Francine

Health Care Provider Wwiork Experience Memberships Program/Service |

Enrallment | Personal | Contacts I Groups I Codes | Health | Mize. | Cond. | User-Def. Muilti-Lrata |
’EE] Allsop, Susan Francine Grade Level: 12

Student No. 100300

Surname Allzop

Firzt Name Suzan

Middle Hame Francine

Preferred Suzan

Gender I Female

Phone Ho. 1[604] 714-6065 [0

Social Sec. Hum. 1705-43-552

Grade Level Bo12

Homeroom Mumber || 102

Track B MR

Home School P Chancery Academy

Birthdate 03 APR 83

Birthplace Yernan, France

Firzt Entry Date 02 0CT 92

Alternate Student i

Delete Picture Load Picture Cancel Done

e Open a tab by double-clicking a record name in the Main window.

e Switch to another tab for that item by clicking on a different tab.
You can define custom tabs from the Tabs menu in School Setup.

e Use keyboard shortcuts to move quickly to other records or tabs:

Previous Record F3 [
Next Record F4
Previous Tab Shift-F3
Next Tab Shift-F4

e To create a record from the Main window, use the New command from
the File menu.

e [If a padlock appears to the left of the record name, you have view-only
password access to that information. You can look at, but not edit, the
record.

Using the Details Module e Using the Details Module 5
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Enrollment | Perzonal I Contacts I Groups

[E] @ Abrosimoff, Martin Frederici

If a padlock appears next to a field, you are running the multi-user
version of Win School, and another user is working on that record.
When the other user finishes, the data updates, the lock disappears, and
the computer beeps.

Using and Editing Popup Menus

A pencil or wedge icon indicates a popup menu. The pencil means you can
edit and select from the field, the wedge means you can only select.

Homeroom Number B 103

Home Languages # German
Ethnic Categories # Canadian
Birthdate Mo 14, 1350
Date Hired kap 30, 1333
Administrator kMo

To select from a popup menu:
e Click and hold on the text to the right of the icon, then scroll.
OR

e  Click and type the first few letters of the entry you want.

To add an item to a popup menu:

1 If a pencil appears to the left of the popup, click the field and press
Ctrl-E. Existing items can only be changed in School Setup.

2 If the dialog contains a Short Code column, type any code of up to 4
characters that does not already appear in the list.

3 Click Add.

Editing Dates

To edit a date:
e Click the field and type.

Some date fields can be set to N/A. Select the month and type N/ or
press Backspace.

Editing Phone Numbers

All phone number elements are optional. The letters L or U indicate listed
or unlisted numbers.

6 Using the Details Module e Using the Details Module
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Working with Data and Records

This section describes the basics of entering and maintaining information in
Details. You can use time-saving techniques, such as using keyboard
shortcuts to move to different records or tabs, or use different ways to select
a range of records.

Entering Data

At the start of a new school year, enter course information first, then enter
teacher, student, and resource information, in that order. After that, you can
enter new students, teachers, courses, and resources in any order.

To enter new records:

1 From the Main window, click the icon for Courses, Teachers, Students,
or Resources.
2 From the File menu, choose New. An empty set of tabs appears.
3 Press Tab to move from one field to the next, or click the mouse in the
field you want to edit.
4 Click the tabs to display different groups of information.
Health Care Provider YWork Experience temberzhips Frogram/Service |
Enrollment | Perzonal I Contacts I Groups I Codes | Health | Mizc. | Cond. | Uszer-Def. Fulti-Drata |

Saving Data

You cannot save a new or existing record until you type the name (last
name for student or teacher) and ID number.

Click Done to save and close the dialog, or click New in the top left
corner of the dialog to save the record and start a new one.

To discard a new record or changes to an existing record, click Cancel.

You can use the Next Record and Previous Record button [E] to
save changes and move to other records without closing and re-opening
the dialog.

Using the Details Module ¢ Working with Data and Records 7
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Selecting Records

Importing Data
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To save time, duplicate records, then edit them:

e Highlight a record in the Main window, then from the File menu,
choose Duplicate.

Sibling records can be created this way. Just change the name, grade and
personal information.

Teacher and course records can be duplicated and assigned to different
tracks.

Fields that are not duplicated are Students’ Activities, Comments, Groups,
Status Codes, User-defined Codes and Conduct. The custom defined fields,
codes, and lists in Multi-Data tabs are also not duplicated.

You can select records quickly using a combination of these methods:

o  (Click the checkbox in the Selected column. The checkbox is checked.
Click the checkbox again to deselect the record.

e  Shift-click an unselected checkbox to select all records.
e  Shift-click a selected checkbox to deselect all records.

e  Control-Shift-click an unselected checkbox to select all records from
that record to the end.

e  Control-Shift-click a selected checkbox to deselect all records from that
record to the end.

e  Control-click an unselected checkbox to select all records from that
record to the last record displayed in that window.

e  Control-click a selected checkbox to deselect all records from that
record to the last record displayed in that window.

The Selected column title shows, in parentheses, how many records are
selected.

You can also select records using Select/Replace/Assign from the Edit
menu. See “Selecting Data” on page 10.

You can work with only the selected records by copying them to a subset.
See “Using a Data Subset” on page 18.

Import student, teacher, or course information from other databases or other
programs with Win School’s ASCII Transfer module. See the Win School
System Administrator Guide and the ASCII Transfer Guide.

8 Using the Details Module e Working with Data and Records
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Deleting Data

When deleting students, create or update an Archive file to contain
historical student information from Details and Report Cards.

If a student or teacher leaves during the current school year, make them
inactive instead of deleting them. If you entered information for the student
in the current year database, we recommend you delete the student in the
next year database after Year End processing, not the current year.

You can hide inactive students by choosing Hide Inactive Students from the
Edit menu.

For more information on Year End processing and managing Archive files,
see the Win School System Administrator Guide.

To delete records:

1 Select records in the Main window by clicking the checkbox in the
Selected column.

2 From the File menu, choose Delete and click Selected.

3 For students, click Yes to archive or No to delete without archiving.

Removing References and Locks

A reference is when another module, such as Scheduler, is referring to a
record. A lock is when another user is modifying a record. The lock is
removed when that user saves the changes.

You must remove the reference or lock before you can delete the record. If
you try to delete a referenced or locked record, the message “Some records
weren’t deleted because they had other references or were currently locked
by another user” appears.

To remove references and locks:
1 If you are on a Multi-user system, go to the Shell.

2 From the Shell menu, choose Administrator Log to see if someone else
is using the record in Details. If so, the record cannot be deleted until
they close the record.

3 Start Scheduler.

e For a student, clear the student’s course requests, and all classes
from the student’s timetable.

e For a teacher, remove all classes from the teacher’s timetable.

e For a course, remove all requests and sections for the course.

Using the Details Module e Working with Data and Records 9
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Using Custom Tabs and Multi-Data Tabs

You can define Custom tabs and Multi-Data tabs containing fields, lists,
and codes. These are in addition to the user-defined fields, flags, lists, and
codes.

In School Setup, use the Tabs menu to define fields, lists, and codes for
students, teachers, and courses. You can also specify which tabs in Details
show the data.

Working with information in Custom and Multi-Data tabs is the same as
working with information in other tabs.

Changing Multiple Records

Selecting Data

Use the Select/Replace/Assign command in the Edit menu to change
multiple records based on criteria you define.

e Select finds and selects data. You can edit or report on this data.
e Replace replaces existing data with new data.
e Assign assigns new data to selected records.

Select/Replace/Assign is a powerful command. Back up your data before
using this command, so you can restore if necessary. Replace data in a few
records first, to make sure you have set the command correctly.

To find and select data elements without changing them, you need only to
use the Search Criteria tab. Each search condition includes a Field,
Relation, Value, Operator, and sometimes, Brackets.

Fields

Use fields to define both the data you want to select, and the data to replace
the found data. Fields identify specific data elements within the database,
such as Student Name, and Gender.

You can define field formats for name, date, and other data, in any field
with a yellow page icon beside it. Double-click the yellow page icon to
change its format.

10 Using the Details Module e Changing Multiple Records
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Search Criteria tab

Search Criteria

End of List marker

| Feplacement ¥ alues |

Replacement Values tab

7

Operator

Field ‘ Relation Yalue

Fs

W

Category
Enrollment ;I
Perzonal
Contacts

Groups

Codes

Health
Miscellansous
Conduct Codes
User Defined

Field Palette
=

Special Program

Counzellor

Ethnic Category

Home Language

Lunch Status

Student Track

Student Groups [ Multiple ltems |

W

Add Remove

Clear All

Cancel | 0K I

To select data:

1
2

In the Main window, select the view you want.

From the Edit menu, choose Select/Replace/Assign. If it is dimmed,

you do not have access to the function. Check with your System

Administrator.

If no items are selected in the Main window, the Select/Replace/Assign

dialog opens displaying the Search Criteria tab.

If you already have items selected in the Main window, the Selected
Items Found dialog appears. Select a radio button and click OK to

display the Search Criteria tab.

Selected ltems Found m

Some items are currently selected. Do you want to:

& Select { Replace } Assign the currently selected items.;

" Clear all selections and search all items.

" Search and add any found items to the selected set.

Cancel

In the upper list of the Search Criteria tab, make sure the End of List
marker is highlighted. If not, highlight the End of List marker — the

horizontal bar under the last field.

Using the Details Module e Changing Multiple Records
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5 In the lower-left list, click the category from which you want to choose
fields. For example, click Enrollment.

6 In the Field Palette list, double-click the field you want to search for.
Or highlight the field and click Add. For example, double-click Student
Homeroom. The item appears in the Field column in the upper list.

7  In the Relation column, click and hold to display options, then choose
one.

8 In the Value column, click and hold to display values, then choose one.
For example, choose 104 as the Homeroom.

9 If you want to search for more than 1 field, use the Operator column to
specify how to join the fields. Click and hold the Operator and choose
“and” or “or”.

For details on using Relation, Values, and Operators, see the
appropriate section following this procedure.

10 Repeat steps 4 to 8 to add another field.

For example, make sure the End of List marker is highlighted, then
choose Groups in the Category list, and double-click Normal Program
in the Field Palettes list. In the Value column, click and choose

Vocational.
Search Criteria | Replacement Yalues
Field Relation Yalue Dperator
] Student Hameroon B equal to Bo104 3 Boand o
I Mormal Prograrm b egual to W ocational B

If you use “and” and “or” for several fields, use the appropriate
brackets to set up the order of operation. Brackets are in the columns
preceding Field and following Value. See “Using Brackets” on page
15.

You can define the formats for fields by double-clicking the icon to the
right of the Field column. If the icon is not yellow, there are no formats
defined.

11 Click OK to begin the search.

When the search process is complete, the items that match your search
criteria are selected in the Main window.

You can copy the selected items to the subset by choosing Copy Selected to
Subset from the Edit menu.

Work in the subset to edit the selected records, include them in reports, or
perform additional replace and assign functions. See “Using a Data Subset”
on page 18.

12 Using the Details Module e Changing Multiple Records
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Setting Relation

You search by setting up a Field, which includes a Relation, Value,
Operator, and sometimes, Brackets.

Relation

Definition

Equal to

The field data must exactly match the Value.

Not equal to

The field data can be anything but an exact match with
the Value.

Contains

The field data must include the Value.

Not contains

The field data must not include the Value.

Start with Text only. The characters at the beginning of the field
data must exactly match the Value.

End with Text only. The characters at the end of the field data
must exactly match the Value.

Start at The field data can be the same as the Value or come
after it alphabetically or chronologically.

End at The field data can be the same as the Value or come

before it alphabetically or chronologically.

Greater than

The field data must be greater than the Value.

Greater or equal

The field data can be the same as or greater than the
Value.

Less than

The field data must be less than the Value.

Less or equal

The field data can be the same as or less than the Value.

Not applicable

Constraints based only on Student Conduct, Status, and
User-defined Codes. If only 1 field in the group is
applicable to the constraint, the other fields are set up as
not applicable.

Assigning Value

e To assign a value for most fields, put the cursor in a Value cell and type

a value.

®  You can leave Value empty for a text field, after the “equal to” or “not

equal to” relation. The template then looks for items that either have no

data entered in the field, or that have any data entered in that field.

e Yes/No flags, checkboxes, popup menu fields, and dates always have
some value, if only N/A, so they are never empty.

e The Value for a numeric field defaults to zero if you leave it empty.

Using the Details Module ¢ Changing Multiple Records
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Constraints are separated by either “and” or “or.” Use the popup menu to
toggle between the 2 options. The order of the constraints is important
when you have a mixture of “and” and “or.”

Use “and” when you want each item to meet more than 1 constraint.

The following examples compare the search results using different
operators when searching for Grades 5 and 6 in Homerooms 100 and 101.

For example, to select a list of Grade 5 students in Homeroom 100, the
grade must be 5 and the homeroom must be 100.

Student Gradeis5 | Hmrm s Grade is 5 and
100 Hmrm is 100

Grade 5, Hmrm 100 Yes Yes Yes

Grade 5, Hmrm 101 Yes No No

Grade 6, Hmrm 100 No Yes No

Grade 6, Hmrm 101 No No No

The same criteria, separated by “or,” generate a much longer list.

Student Gradeis5 | Hmrm s Grade is 5 or
100 Hmrm is 100

Grade 5, Hmrm 100 Yes Yes Yes

Grade 5, Hmrm 101 Yes No Yes

Grade 6, Hmrm 100 No Yes Yes

Grade 6, Hmrm 101 No No No

For a list of Grade 5 and 6 students, students would not be in 2 grades at the

same time.
Student Grade is 5 | Grade is 6 Grade is 5 or
Grade is 6
Grade 5 Yes No Yes
Grade 6 No Yes Yes
Grade 7 No No No
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Replacing Data

Using Brackets

Use brackets to set up the order of operation when using a mix of “or” and
“and” operators. When you include more than 2 or 3 search criteria, the
logic of the expressions is more complex — particularly if you have a
mixture of operators. As a result, records may not be found.

The order in which you list criteria is important. Data is analyzed for the
first criterion, then the second, and so on. Only data that meets all the
criteria is selected.

Examples

When the order of operation is simple, don’t use brackets, as in these 2
examples:

grade = 11 or homeroom = 104 or grade = 10 or homeroom = 101
grade = 11 and homeroom = 104 and grade = 10 and homeroom = 101

When the order of operations is not simple, use brackets to indicate the
order, as in this example:

(grade = 11 or homeroom = 104) and (grade = 10 or homeroom = 101)

The Replace function replaces data in records selected by the Search
Criteria.

Use the Replace function when global data changes are needed or when
you’re preparing data for a new year. For example, this function is useful if
you want to move all students in one homeroom to a different homeroom,
or give all students in one homeroom the same counselor.

When using the Replace function, define both the Search Criteria tab and
Replacement Values tab in the Select/Replace/Assign dialog. The
Replacement Values tab also has a Field and a Value column.

The Replacement Method column is only needed when you use a Group
field. See “Choosing a Replacement Method” on page 17.

When you click OK, Select/Replace/Assign completes the entire process of
search, select, replace, and assign without intervention.

When replacing a student status code, you cannot replace or delete the first
Entry enrollment code.

To replace data:
1 Complete the Search Criteria tab.

2 Complete the Replacement Values tab. If necessary, define the formats
of fields. Click OK to start the replacement.

To check the data that was replaced, look at individual records.
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The Assign function both replaces data and enters new data in selected
records. Assign writes data to selected fields, whether the fields already
hold data or are empty.

Assign is often used to prepare data for a new year, for example, assigning
all students in one homeroom to another.

You can also use Assign when new data does not relate to existing data. For
example, manually selecting students to be assigned to a counselor.

Use Assign after selecting records, then assign a new condition.

To assign, use only the Replacement Values tab on selected records. Do not
use the Search Criteria tab.

You cannot replace or delete a student’s first Entry enrollment status code.

To assign data:
1 Select the view and the records to assign data.
2 From the Edit menu, choose Select/Replace/Assign.

3 In the Selected Items Found dialog, choose the “Select/Replace/Assign
the currently selected items” radio button. Click OK.

4 Click the Replacement Values tab and choose the field(s).
5 Click OK to assign the data.

Changing Codes and Group Records

You can include multiple fields in the Search Criteria tab, or you can use a
group field, such as status codes or student groups. A group field includes a
series of items and is identified by [Multiple Items] following the name in
the Field Palette column.

You can use only one group field in a search, replace, or assign. If you need
more than one group field, repeat the search, replacement, or assignment for
each group.

In the Search Criteria tab, you can change the Relation, Value, and
Operator of each item in the group field, and you can add and change
brackets. See “Setting Relation,” “Assigning Value,” “Choosing Operator,”
and “Using Brackets” on pages 13 to 15.

In the Replacement Values tab, use the title in the first line of the group
field to choose a replacement method. You can also change the Value and
Replacement Method for each item in the group.

To delete a group field, highlight its title in the upper list and click Remove.
You cannot delete items within a group, you must delete the whole group.
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Choosing a Replacement Method

How you define the Search Criteria depends on the Replacement Method
you choose. You must set up Replacement Values for all replacement
methods. The table below lists each Replacement Method, what it does, and

its Search Criteria requirements.

Sample Results of Each Replacement

Method
Replacement Search Criteria Existing Replace-
Method What It Does Requirements Data ment Data Results
Add to Adds the None. No reference to | Photo Club Drama Club | Photo Club
existing replacement data | existing data is
at the end of the required for an Yearbook Yearbook
existing data. addition. Drama Club
Replace first | Replaces only the | Required. Fields must | Photo Club Drama Club | Drama Club
match first matching correspond to the
occurrence of the | Replacement Values Yearbook Yearbook
data. set.
Replace all Replaces all Required. Fields must | Photo Club Drama Club | Drama Club
matches matching correspond to the
occurrences of the | Replacement Values Yearbook Yearbook
data. set.
Delete first Deletes only the Optional. If selected, Photo Club none Yearbook
match first occurrence of | the first matching
the data. occurrence of the data Yearbook
is deleted. If not
selected, the first
existing group is
deleted.
Delete all Deletes all Optional. If selected, Photo Club none all groups
occurrences of the | all matching deleted
Yearbook

data.

occurrences of the
data are deleted. If not
selected, all
occurrences are
deleted.

Example of Selecting and Replacing a Group Field

1 In Students view in the Main window, choose Select/Replace/Assign
from the Edit menu, then click the Groups Category, and double-click
Student Groups [Multiple Items].

2 To replace only the group name, choose Baseball as the Value for the
Student’s Group.
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For all the other items in the group, choose not applicable in the
Relation column.

Field Relation Yalue Operator
B[ | Student Groups -
[ Student's Group B equal to  Baszeball [ foand
3 Group Membership Start D ate B notapplicable | Jan 07, 98 3 B and
e Group Memberzhip End D ate B notapplicable | Jun OF, 98 o1 I
— e——T
3 Click the Replacement Values tab.
4 In the Replacement Values tab, click the Groups Category, then
double-click Student Groups [Multiple Item].
5 In the Replacement Method column on the right, choose replace all
matches.
6 For the Student’s Group, choose Choral Group for the Value, and
applicable for the Replacement Method.
7 Leave not applicable as the Replacement Method for everything else,
then click OK. Win School completes the search, select, and replace.
Replacement
Field Value Method
Student Groups b replace all matches = |
Student's Group F2 b Choral Group b applicakle
Group Membership Start Date E? Jun 09, 95 b not applicakble
Group Membership End Date E? Jun 049, 98 b not applicakle

Using a Data Subset

The search is on the group name and only the name is replaced or
assigned. The dates are ignored.

Use a data subset to work with non-sequential records. Select records in the
Main window, copy them to the Subset window, then work with them as
you would in the Main window. Changes you make to a subset are saved
just as they would be in the Main window.

When you work with dialogs in a subset record, the =4 and =l buttons
move through the subset records, not the main records.

To use a data subset:

1
2

Select records in the Main window.
From the Edit menu, choose Copy Selected to Subset.

Click the Subset button under the view icons to work with the subset.
Any changes you make to the subset are saved exactly as they are in the
Main window.
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AR

Courses Teachers Studentz || Resources

| All Courzes I Course Subzet |

4  To clear the subset, choose Clear Subset from the Edit menu.

5 To return to the Main window, click the All button under the view
icons.

Recording Transfers in Student Records

Use Transfer Recording to keep track of transfers for homeroom, grade,
track, and normal program. Turn on Transfer Recording in School Setup to
log transfers within the current school year. Use the Transfer Editor in
Details to display and edit student transfers.

Transfers are ordered by type and date in lists. Each transfer type has its
own list. The first start date in each list is the date of enrollment and cannot
be changed. This is the first date that the student joined the homeroom,
grade, track, or normal program.

If you add transfers, each transfer defaults to the next sequential date.
Each transfer of any type must have a unique date.

If you have a large database, recording transfers might slow down
Win School.

To turn on transfer recording:
1 Quit Details.
2 Start School Setup.

3 From the School menu, choose Transfer Recording, then click Yes to
log changes.

4  Click OK.
5 Quit School Setup.

To display and edit transfers:

1 Start Details.

2 Highlight a student record.

3 From the Edit menu, choose Transfer Editor.

e To change a transfer, choose from the popup menu in the
homeroom, track, grade, or program list.
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e To change a date, highlight the date and type the new one, pressing
Tab to move from month to day to year.

e To add a transfer, click the list where the transfer is being added,
then click Add.

Choose the appropriate option from the popup menu.
Type the effective transfer date.

e To print a transfer report, click Print to display the report. To send
the report to the printer, choose Print from the System menu.

The System menu is the icon directly to the left of the window title.

: —_—
/ [£12]age &ié | Corpea o 20|

System
menu Alexander, Richard Darren
# Homeroaom Membership Start Date
1 100 Enroliment
2 1M Fri, Mo 27,1995

For a more compact version of this report, see “Student Transfers
Report” on page 65.
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Entering Course Details

Overview

General Tab

Course information is required for the Scheduler and Report Cards
modules. After you create courses in Details, you can create classes, which
are the sections of each course, in Scheduler or Report Cards.

If you only use the Attendance module, and do not record attendance by
class, you do not need to enter course information in Details.

Changes cannot be made to the following fields in Course Details after you
create sections for a course:

Tab Field

Scheduler Course length (in terms)
Scheduling Credits
Use in Scheduler
District Use Only

Periods No. of unique block letters

For both elementary and high schools, courses are directly related to marks.
If different marks are reported for different subjects such as Language Arts,
Social Studies, or Arithmetic, create one course for each different subject.

Each tab is discussed in order from left to right, top to bottom, as it is
displayed in Details.

The General tab contains basic information about each course.

Chemistry 12 ]
General | Fep. Cards I Scheduler I Periods | Listz | User-Def. I

Chemistry 12

Course No. 160 District Active B es

Course Name Chemistry Termination Date M

Alternate Name Show In Attendance | “es

Grade Level B2 Show In R. Cards P Yes

Subject Area P Keep History B Yes

Course Type o MAA Course Factor 1 0.000

Sequence Number 0 Course Factor 2 0.000

Department # Science Course Fee 0.00

Grad Rgmnt. b ez Book Fee 0.00

Courze Weighting P Mot Weighted Local Courze B Mo

Min. per wk. 120 Track MR
[ Courze C ks |
| -1
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Course No.

Course numbers can have up to 9 characters, common or unique, numeric
or alphanumeric, as you defined in School Setup. To use Scanning to enter
student requests, course numbers must be unique and numeric.

Course Name

Course names can have up to 20 characters. Do not include grade levels in
course names. If you use Scheduler, make the Course Name or the
Alternate Name as concise as possible. Some columns might be too narrow
to display all 20 characters.

Alternate Name

Optional. Alternate names can be up to 20 characters. Some users have 2
versions of the course name, one abbreviated. Other users have a version of
the name for internal use only (Honors Math 11) and another for timetables
and reports (Math 11). Both fields are available in Scheduler, and you can
toggle between them. In Report Manager, you can create reports showing
the Course Name or Alternate Name.

Grade Level

You must set up grades in School Setup. The grade of a course is used by
Scheduler to determine required and requested status for various students in
various courses. If a course, such as Lunch or Study Hall, has no grade,
choose N/A.

Subject Area and Course Type

Optional. You can set up Subject Areas and Course Types in School Setup,
Courses menu. For example: Special Education, English Second Lang.,
Apprenticeship, or College Prep. Or you can classify by type of work, for
example: Academic, Project, or Lab.

Sequence Number

Optional. You can sort courses and classes by their sequence number in
lists and reports. If a specific order is required on report cards, such as
academic courses first, use sequence numbers. Low numbers appear first in
the list, and you can type numbers up to 32,000.

Department
Optional. You can set up departments in School Setup, Details Lists menu.
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Grad Rgmnt.

Optional. Choose Yes for students who must pass the course to move to the
next grade. This setting does not affect Scheduler. If set to Yes, a student
who fails the course has a Failed status in class rank calculation in Report
Cards.

Course Weighting

Optional. You can make weighted and regular GPA calculations in Report
Cards. The weighted calculations benefit students taking more demanding
courses. Usually, schools weigh academic courses.

Min. per wk.

Optional. Number of minutes per week of instructional time for 1 class of
the course. You can report on this figure in custom reports. Otherwise, it is
not used by Win School.

District Active

Optional. Set this to Yes for courses being taught in the current year, and
set to No for courses not being taught, but being retained for future years.

Termination Date

Optional. In most cases, the date should be N/A. If the course is going to be
withdrawn from your curriculum, type its termination date.

Show in Attendance

If you take class or period attendance, set this field to Yes. Set courses such
as Lunch to No, so they don’t appear in the Attendance module.

Show in R. Cards

For the Report Cards module. For courses you want to appear in Report
Cards, set to Yes. For courses such as Lunch and Homeroom, set to No.

Keep History

If Show in Attendance is set to Yes, then you must set Keep History to Yes.
If you do not take attendance for this course, set to No.

When you set Keep History to Yes, Scheduler keeps a historical roster of
the class, so that Attendance and Scanning show who was in each class on
any given day, even if the students transfer out of the class.

If Keep History is set to No, the historical roster is not kept, which saves
disk space, but you cannot track attendance for that class.
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If you use Scheduler and keep period attendance, set Keep History to Yes
for most classes. For courses such as Lunch, set to No.

Course Factor 1 and 2
Not currently used.

Course Fee and Book Fee

Optional. If your school charges a fee for courses or books, type the fee.

Local Course

Optional. Choose Yes if the course was created by someone at your school
and is not normally taught at other schools.

Track

If your school is a year-round school or if you use the Track field for
another purpose, choose a track. A course can belong to only 1 track. You
must create a separate course for each track in which a course is taught.
Duplicate data to build courses quickly; see “Duplicating Data” on page 8.

Rep. Cards Tab

All information in this tab is for the Report Cards module.

All Report Card bins created in School Setup are listed in this tab. The 5
columns following the Bin Name column match fields that appear for each
bin in the Report Cards module. In this tab, set the default values for the
course in the Report Cards module.

Initial default values are read from Details and entered into Report Cards.
Later changes are not read by Report Cards. To update bin information
from Details, use Clear/Set Bin Info in Report Cards.

Chemistry 12 [ |

General Rep. Cards | Scheduler | Periods | Lists | User-Def. |
[g] Chemistry 12

Potential Use in Iz Final
# Bin Name P & C Table Credits GPA  UseinEC  Mark
1 | First Quarter b 01 Academic Cours... 0.000 | b Yes b es B Mo -
2 Second Quarter b 01 Academic Cours... 0.000 | b Yes B es B Mo
3 | First Semester B 01 Academic Cours... 0.000 | b Yes B es B Mo
4 | Third Quarter B 01 Academic Cours... 0.000 b Yes b es B Mo
5 | Fourth Quarter b 01 Academic Cours... 0.000 | b Yes B es B Mo
6 Second Semester B 01 Academic Cours... 0.000 | b Yes B es B Mo
7 | Final Mark B 01 Academic Cours... 2000 | b Yes B es B es

Used for cumulative earned credits

ERON 1] 12!
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P & C Table

For each bin, choose the Points & Credits table to be used for this course.
Up to 15 Points & Credits tables can be created in School Setup.

Potential Credits

If you change a Potential Credit, use Clear/Set Bin Info Report Cards to update
the change.

The potential credit value of a course is the maximum number of credits a
student can earn in the course.

Type the number of potential credits each bin represents. If potential credits
are awarded using 1 final mark only, put the full potential credit value in
any bin that can contain the final mark. If final marks are a combination of
several bins, divide the potential credits among those bins.

If you use a GPA or earned credit formula that weights marks using
potential credits, type a potential credit value in any bin that can be used for
GPAs or earned credit totals. Potential credit value must reflect weighting.

A bin with zero potential credits counts as zero and is not included in
calculations.

Use in GPA and Use in EC
Set Use in GPA to Yes for all bins containing marks to be used in GPA
calculations.

Set Use in EC to Yes for all bins containing marks to use in earned credit
calculations.

In the Report Cards module, the Used in GPA and Used in E. Credits
checkboxes will be selected for these bins. If you change a Use in GPA or
Use in EC setting, run Clear/Set Bin Info in the Report Cards module to
apply those changes to bins you have already edited.

Is Final Mark
Set Is Final Mark to Yes for bins to be used for the final GPA and earned
credit calculations.

If final marks are a combination of several bins, choose Yes for each bin. If
no mark is found in a bin, that bin is not included in the average.

If a student has marks in more than 1 bin in which Is Final Mark is selected,
grade points from those bins are averaged and credits are totaled.
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Used for cumulative earned credits

Select the grades of students who can have credit for the course added to
their cumulative earned credits.

If any student can get credit, select all grades.

If Grade 12 students cannot get credit for a Grade 8 course, deselect Grade
12.

Grades defined as Not Used in School Setup do not appear in this list.

The information in this tab is for the Scheduler module.

Chemistry 12 B

General | Rep. Cardz Scheduler | Periods I Lists I Uszer-Dief. |
’g] Chamistry 12

Scheduling Term Information

Courge Length [in terms) 2
Terms are consecutive B es
Course can start in term(s) 2 EE 4
Courze can be taught in term(s] (1213 4]

Clazs Information
Teacher Required I Yes Room Required b ves
Maximum Class Size 30 Scheduling Credits 2000
Minimum Class Size 25 Student Clusters P Mo
Student Mix B Co-ed Use in Scheduler b Wes
EFT 20% Aide Type b MAA
Preceding Course B M District Use Only b Mo
Allow Clags Combining B Ma

Cancel Done

Course Length (in terms)
Type the number of terms that 1 section of this course will be taught.
The number and date ranges of terms are created in the School Setup

module, Set Scheduler Terms menu. The number of terms you created is
shown in Course can start in term(s), and Course can be taught in term(s).

Terms are consecutive

Choose Yes if the course runs for more than 1 term and those terms must be
consecutive.
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Course can start in term(s)
Select the terms in which classes can start for the course. The length of the
course can restrict the possible starting terms.

Create number and date-ranges of terms in School Setup, Set Scheduler
Terms menu.

Course can be taught in term(s)

Select the terms in which classes can be taught for a specific course.

Create number and date-ranges of terms in the School Setup module, Set
Scheduler Terms menu.

If your school is a year-round school, it is imperative that you deselect the terms
that are holidays for the course track.

Teacher Required

Choose Yes so the Scheduler module will not place students without a
teacher. The Assign Students option of Scheduler can manually override
and place students without an assigned teacher.

Select No for courses such as Lunch.

The Create Timetable function in Scheduler always tries to schedule classes
with teachers and rooms, whether or not Yes is selected. If you want to
schedule a class with no teacher, either schedule it manually, or, in
Scheduler, check the “Ignore rooms and teachers” checkbox in the Create
Timetable dialog in the Schedule menu.

Maximum Class Size

Type the maximum number of students that can take 1 section of this
course. Scheduler uses this number to calculate the minimum number of
sections necessary to fill requests for the course.

Minimum Class Size

Type the minimum number of students that can take 1 section of this
course. No matter what number you use as the minimum class size, if the
course has a request, Scheduler will create at least 1 section of the course.

You can select minimum class size based on an average class size. Use the
following formula:

Minimum size = (2 x Average size) - Maximum size
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If you want an average class size of 25 and the maximum is 30, you would
type a minimum of 20:

Minimum size = (2 x 25) - 30

Minimum size = 50 - 30

Minimum size = 20
Do not set your Minimum class size to a very low number. Use the formula

provided. Otherwise, too many sections will be created in Scheduler. In the
Scheduler module, you can manually change the number of sections.

Student Mix

If you want, choose any gender restrictions for this course. Student request
and student timetable windows in Scheduler display gender restrictions.
Assign Required in Scheduler will not generate requests for a course for
students who do not meet its gender restrictions.

EFT
Optional. Type the percentage of a full-time teacher load that teaching a
class of this course would represent.

Equivalent Full Time (EFT) report in the Scheduler module uses these
values to calculate the teacher resources used by each course and
department.

Preceding Course

Optional. Choose any course that students must be scheduled into before
being scheduled into this course. All sections of the Preceding Course will
be scheduled in a prior term before any sections of the course you are
defining.

Allow Class Combining
Optional. If the course can be combined with another, choose Yes.

Room Required
Choose No for courses such as Lunch. Choose Yes for most courses.
The Assign Students function in Scheduler places students in a section only

if a room is required. To place students in the class anyway, use an Assign
Students option.
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Scheduling Credits

Optional. Type the maximum scheduling credit value of the course. You
can use up to 3 decimal points. Scheduler uses this value to tally the
number of credits requested and scheduled for each student. Scheduler
compares Scheduling credit totals with the required credit total defined in
School Setup for each program and grade.

Report Cards does not use Scheduling Credits, only Potential Credits as
defined in the Rep. Cards tab, and the students’ earned credits.

After sections have been set for a course, this field cannot be changed.

Student Clusters

Choose Yes if students in 1 or more programs take this course in student
clusters. Identify which programs have students take this course in clusters
by making this course Required for those programs in the Required view of
the Lists tab.

Use in Scheduler

Choose No to prevent the course from appearing in course or class lists in
Scheduler, and to prevent students from being scheduled into the course.

Aide Type
If the course requires teacher aides, choose an aide type, otherwise, choose
N/A to ensure that no aide is assigned.

District use only

Choose Yes to have the course appear in course or class lists in Scheduler,
but only when Show All District Items is also selected in Scheduler
Preferences.
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Periods Tab

The information in this tab is for the Scheduler module.

General | Rep. Cards | Scheduler Periods | Lists | User-Lief.
[g] Chemistry 12

Usable Blocks{Periods for this course

Periods

Extra Periods

1

2

3

4

5

6

7

Other block/period info

Mo. of unique block letters. .. 1 Same periods each day P ves
_..spread over how many days 1 Consecutive perniods B Ve
Periods per day 1 All sections in the same blocks [P Mo

Usable Blocks/Periods for this course

Select the blocks, days, and periods into which the Create Timetable
function can schedule the course. The selected blocks are also identified in
the dialog where you manually schedule classes. Create Timetable will not
schedule the course into deselected blocks, but you can do it manually.

If you have repeated blocks in your timetable, when you click one block
letter, the same change is made for all copies of that letter. Whatever is
scheduled in a block in one place in the timetable is scheduled in that block
everywhere.

Do not be more restrictive than necessary. The more restrictive you are, the
more difficult it will be to schedule your school. If a course can only be
taught at a certain time, schedule it manually and lock it before using
Create Timetable to schedule the rest of the classes.

e Click a block to select or deselect it.
e Shift-click any block to select or deselect all blocks.
e Control-click a block to select or deselect all blocks in that period.

e Control-right-click a block to select or deselect all blocks in that day.

Extra Periods

Select Extra Periods for days that a class meets extra times, or if a section
of the course is taught more frequently on some days than on others, such
as courses like band or theatre, when long rehearsals are needed.
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Scheduler schedules the number of blocks per day, then divides any
remaining blocks among the days with Extra Periods selected, according to
the number of blocks you set.

If the extra period can be on any day, select Extra Period(s) on all days.
Create Timetable picks as many days as necessary from those selected.

No. of unique block letters

Scheduler uses this number to determine whether or not a class is fully
scheduled in the school timetable.

After sections have been set for a course, this field cannot be changed.

Type the number of blocks for 1 section of the course. If your block
timetable has repeating blocks, count a repeated block only once.

Spread over how many days

Type the number of different days from which Scheduler should pick
blocks for each section of this course. This number cannot be greater than
the number of unique block letters.

If every day has all new block letters, the maximum number of days is the
number of days in your cycle.

If your timetable has repeating blocks, type the number of days in which a
new block letter is introduced. If all block letters appear on Monday, and
Tuesday through Friday contain repetitions of Monday block letters, then
the maximum number of days you can type is 1.

Periods per day

Type the number of periods per day 1 section of the course will be taught. If
classes meet a different number of times on different days, type the lowest
number (not zero). Select Extra Period(s) in the block timetable in this tab
for all of the days in which the class meets or can meet more than the
minimum number of times.

Same periods each day

Choose Yes if you want each section of this course to meet in the same
period each day. Different sections can meet in different periods. If you
select any Extra Periods, choose Yes for Same periods each day.

Consecutive periods

Choose Yes for periods to be consecutive in a day. If you select any Extra
Periods, choose Yes for Consecutive periods.
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All sections in the same blocks

If you want all sections of this course to meet at the same time, choose Yes.

The course cannot belong to a Following Triplet or Linked Group.

Lists Tab

All the information in this tab is used by the Scheduler module.

e To move a listed item from the right column of the tab to the left
column, double-click that item.

e Toremove an item in the left column, select it and press Delete.

General | Rep. Cards | Scheduler | Periodz @ | Usger-Def.
[E] Chemistry 12

D g . ve e &
i 5 o e
E.E

Frerens Co-reqs Rooms Required || Requested || Resources

Pleleiuisiles Courze Pool

Algebra12 —
Biologyw 11 —
Biology 12

Biology Lab 11

Biology Lab 12

Bookkesping 12

2
3
4
5
9
E

Prerequizite Requirement
fr Al of the above prerequisites

The icons under the course name change the display in the tab.

Prerequisites

Prerequisites are courses that must be passed before taking another course.
In the student request and student timetable windows for each course,
Scheduler shows completed prerequisites and lists missing prerequisites.

In the Course Pool list, double-click all Prerequisites for the course. In the
Prerequisite Requirement popup menu, choose whether students have to
meet one or all of the listed prerequisites.

Co-requisites

The Co-requisites list operates like the Prerequisites list. Co-requisites are
courses students must take in the same term as another course. If Scheduler
finds a co-requisite missing, it gives the student a request for the
co-requisite.

In the Course Pool list, double-click all Co-requisites for the course.
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Rooms

The Preferred Rooms list determines the rooms or room types in which the
course can be taught. Restrict as little as possible.

If you can, give priority to either teacher room preferences or course room
preferences, then be as restrictive as necessary with 1 set of preferences and
as unrestrictive as possible with the other. Scheduler needs at least 1
common room for the course and teacher. Problems in scheduling are often
caused by conflicting room preferences.

In the Room Pool list, double-click the rooms suitable for the course. If the
course can be taught in any room, delete all room types from the Preferred
Rooms list.

Required

Identifies the programs for which the course is required.

The course is identified as required in the Student Request and Student
Timetable windows of Scheduler, for any student in one of these programs,
in the same grade as the course, and meeting any gender restrictions for the
course. The Assign Students function in Scheduler gives preference to
required courses when filling student requests.

The Program Pool contains all normal programs, followed by all special
programs, which are marked with asterisks.

The order of Required Programs is not important. A course can be required
for a maximum of 20 programs.

In the Program Pool list, double-click the program for which this course is a
requirement.

Requested

Identifies the programs for which you want to generate requests for
students.

The Assign Required function in Scheduler gives a request for the course to
any student in one of the programs, in the same grade as the course, and
meeting any gender restrictions for the course.

The Program Pool contains all normal programs, followed by all special
programs, marked with asterisks.

A course can be requested for a maximum of 20 programs. The order of
items is not important.

In the Program Pool list, double-click the programs whose students should
request this course.
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Resources
Assign resources required for the course to a maximum of 20 per course.
Resources records are created in Resource Details.

In the Resource Pool list, double-click the resources required for this
course.

The information in this tab is used only for custom reports.

The user-defined fields and flags named in School Setup appear in this tab.
Type the data according to your school specifications. Up to 15 characters
can be typed in text fields.

Custom Tabs (Courses)

Optional. The information in these tabs is used only for custom reports.

In addition to the data in the User-Defined tab, you can define up to 10
Custom tabs containing fields, codes, and lists.

Custom tabs appear in its own row. Only defined tabs appear. If you do not
define any Custom tabs, then no Custom tabs appear.

The default access level for Custom tabs is None for all users other than the
Administrator. Assign access levels in School Setup, Passwords menu.

To define Custom tabs, use the Custom Tab Designer in the Tabs menu in
School Setup.

Multi-Data Tab (Courses)

Optional. The information in this tab is used only for custom reports.

In addition to User-Defined and Custom tabs, you can define a Multi-Data
tab containing fields, codes, and lists.

You can define up to 2 titles or headings for the Multi-Data tab. Use the
VCR buttons to switch headings.

Only the defined headings appear. If you do not define anything for the
Multi-Data tab, it does not appear.

The default access level for Multi-Data tabs is None for all users other than
the Administrator. Assign access levels in School Setup, Passwords menu.

To define the Multi-Data tab, use the Multi-Data Tab Designer from the
Tabs menu in School Setup.
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Scheduling Courses

You can set up courses to be taught at the same time or in consecutive
periods. You can also set up courses to be taught in the same period on
different days or different terms.

Scheduling Courses in Consecutive Periods

To set up courses that must be taught in consecutive periods, use the
Following Triplets/Linked Groups command.

Following Triplets is a group of 2 or 3 courses that Scheduler should
schedule in consecutive periods, such as Biology and Biology Lab. These
courses get scheduled in the order you specify in the Following Triplets
dialog.

A course can belong to either a Following Triplet or a Linked Group, but
not both. Linked Groups are courses that are taught at the same time.

Following Triplets/{Linked Groups m

Triplets Graups

Following Triplet 2

<] AN
4 Biology 12

9Biology Lab 12

Course Hame Triplet/Grou

1 Algebra 11 -
2 &lgebra 12

3 Biology 11 Following Triplet 1

4 Biology 12 Fallowing Triplet 2

5 Biology Lab 11 Fallowing Triplet 1

9 Biology Lab 12 Fallowing Triplet 2

NewTripIetI Mew Group| Cancel Done

To assign courses to consecutive periods:

1 In the Courses view of the Main window, choose Following
Triplets/Linked Groups from the Details menu.

2 Click the Triplets icon to display Following Triplets in the upper list.

The lower list displays all courses on the left, and whether a course
already belongs to a triplet on the right.

Use the horizontal scrollbar at the top of the upper list to see triplets.

If the top list is blank, go to Step 4.

Entering Course Details o Scheduling Courses 35



Win School Details

3 Click New Triplet.

4 In the lower list, double-click course names in the order they are to be
scheduled. A Triplet can include 2 or 3 courses.

To delete a Following Triplet:

e Find the Triplet using the horizontal scroll bar in the upper scrolling
list. Highlight each course, then press Delete.

Scheduling Courses in the Same Period

To set up courses that must be taught in the same period on different days
or in different terms, use the Following Triplets/Linked Groups command.

Linked Groups are courses that Scheduler should schedule in the same
period on different days, such as Algebra and Geometry, so that students
have a Math class the same period everyday. There is no limit to the
number of courses you can set up in each Linked Group.

A course can belong to either a Following Triplet or a Linked Group, not
both.
To assign courses to the same period:

1 In the Courses view of the Main window, choose Following
Triplets/Linked Groups from the Details menu.

2 Click the Groups icon to display existing Linked Groups in the upper
list.

The lower list displays all courses on the left, and whether a course
already belongs to a group on the right.

Use the horizontal scrollbar to see existing groups.
If the top list is blank, go to Step 4.

3 Click New Group.

4 In the lower list, double-click course names in the order they are to be
scheduled. A group can include unlimited courses.

To delete a Linked Group:

e Find the Linked Group using the horizontal scroll bar in the upper
scrolling list. Highlight each course, then press Delete.

36 Entering Course Details e Scheduling Courses



Win School Details

Entering Teacher Details

Overview
Teacher records are required for classes created in Report Cards or
Scheduler.

You must set up all Win School users, regardless of their position. Set up
non-teaching staff members as Don’t Schedule in the Scheduler tab.

Each tab is described in order from left to right, top to bottom, as displayed
in Details.

Personal Tab

This tab contains basic information about each teacher or staff member.
You must enter a surname and teacher number before you can save a
record. We recommend you also set up homeroom numbers as soon as

possible.
Personal | Miscellansous | Scheduler | User-Def.
g] Arness, James Earl

School ID B Chancerny High Schoaol Aclive B es
Employee Mumber 137 Inactive Date A2
Teacher Humber 28 Department # Math
Title F4L0 Homeroom Number || 102
Surname Amness Home Languages # English
First Mame James Ethnic Categories # Caucasian
Middle Hame Earl Birthdate Feb 21, B1
Social Sec. Num. 27R9275-257 Date Hired Apr OB, 88
Address 1 1 Sleepy Hallaw Administrator B No
Address 2 Counsgelor b fes
City # New Westminster Dept. Head B No
State FA:) Substitute b Mo
Zip Code aveeg Position B Teacher
Home Phone _ [ ) 4878207 m} Track B M
Gender B Male

School ID

Select a home school for the teacher. Teachers can be sorted by school

name.

Employee Number

Optional. Type an employee number of up to 9 characters. This number can
be the same as the Teacher Number.
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Teacher Number

Type a unique teacher number of up to 9 characters. Teacher numbers are
used throughout Win School.

Address 1, Address 2, City, State, Zip Code, Home Phone

Type address information and home phone number. Select city and state
from the popup menus. The area code and extension number are optional.

Active

For most teachers, choose Yes.

When teachers go on temporary leave from the school for the current year,
choose No instead of deleting them from the database. You can change

them back to active when they return. You can exclude inactive teachers in
reports.

Inactive Date

Optional. If a teacher is leaving the school, you can type the effective date
of resignation. This information is available for custom reports.

Homeroom Number

Homerooms already assigned to other teachers are dimmed and cannot be
chosen. Teachers can be sorted by homeroom.

Home Languages, Ethnic Categories

Optional. You can change these options in School Setup, Student - General
menu.

Administrator

If Yes, this teacher is added to the list of administrators that appears in the
student Conduct tab.

Counselor

If Yes, this teacher is added to the list of counselors that appears in the
student Groups tab.

Dept. Head
Optional. This information is available for custom reports only.
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Miscellaneous Tab

Scheduler Tab

Substitute

Optional. This information is available for custom reports only.

Position

Optional. This information is available for custom reports only. Principal
can be selected for only 1 person in Details. When Principal is assigned, it
is dimmed in the popup menu for all other staff members.

Track

Select a track if your school is a year-round school or uses Track for
another purpose. Teachers can be sorted by track. If teachers teach more
than 1 track, they must be duplicated. See “Duplicating Data” on page 8.

The Miscellaneous tab contains contact and credentials information for the
teacher. The information in this tab is optional. It is used for Query and
reporting purposes only.

Teacher Credentials
This is a scrolling text field. Type any characters.

The data in this tab is used by the Scheduler module. If you don’t use
Scheduler, ignore this tab.

e To move an item from the right column of the tab to the left column,
double-click the item.

e Toremove an item from the left column, highlight it and press Delete.
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Rooms View
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Personal I Mizcellaneous Scheduler User-Def.
[si2]  Arness. James Earl
5 H
Courses Roors
Preferred Courzes Courge Pool
1 KT
b1 2 Algebra 12 —l
[ 15 hdath 11 3 Biolagy 11 —
4 Biology 12
5 Biology Lab 11
9 Biology Lab 12
B Bookkeeping 12
|7 Chemistry 11 N
Scheduling Teacher Type P Teacher [
Mazimum blocks teacher can be scheduled for 10 M azimum 35

Click the Courses icon to display the Courses view.

Preferred Courses and Course Pool
Set up the courses that the teacher can teach, then assign what preference
the teacher has for teaching the course.

When you choose a number to indicate the teacher preference for the
course, use the following legend: 9 as best-teacher-for-course, 5 as can-
teach-course, and 1 as unsuited-for-course.

For teachers with the same preference number, the Load Teachers function
in Scheduler loads teachers by total course load, with the lowest first, to
balance teacher loads.

To set teacher courses and course preferences:

1 In the Course Pool list, double-click all the courses the teacher can
teach.

2 In the Preferred Courses list, choose the teacher preferences for each
course you set up.

Click the Rooms icon to display the Rooms view.

Preferred Rooms and Room Pool
Set up a maximum of 8 rooms and room types. Order is unimportant.
All room types and rooms appear in the Room Pool list. Rooms from other

schools and rooms not designated For Scheduler in the School Setup,
Rooms menu do not appear in the Room Pool.
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User-Def. Tab

Scheduler must find at least 1 common room in the Rooms lists of the
course and its teacher. Scheduling conflicts are often the result of
incompatible teacher and course room preferences.

Restrict as little as possible. Give priority to either teacher room preferences
or course room preferences, then be as restrictive as necessary with 1 set of
preferences, and as unrestrictive as possible with the other.

To set teacher room preferences:

e In the Room Pool list, double-click all the rooms in which the teacher
can teach.

Scheduling Teacher Type
Set up whether the teacher is an actual teacher or a teaching aide.

The normal setting is Teacher, which Scheduler loads for courses, using the
course preferences you set in this tab.

Use Teaching Aide, Substitute, or Don’t Schedule for non-teaching staff.
The record will not load automatically in Scheduler. If you want the person
to be scheduled to teach a class, manually load or schedule the person.

To set teacher type:

1 In the left popup menu, choose the teacher type.

2 If you choose Teaching Aide, choose the Aide type from the right
popup menu.

Maximum blocks teacher can be scheduled for

This is the maximum teacher load defined in School Setup, which you can
lower for a teacher if the teacher has other duties. Type the teacher’s
maximum teaching load, if it is lower than the maximum.

Optional, used only for custom reports.

The user-defined fields and flags you created and named in School Setup
appear in this tab. Type the data according to your school specifications, up
to 15 characters in text fields.
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Custom Tabs (Teachers)

Optional. The information in these tabs is used only for custom reports.

In addition to the data in the User-Defined tab, you can define up to 10
Custom tabs containing fields, codes, and lists.

Custom tabs appear in their own row. Only the tabs you define appear.

The default access level for Custom tabs is None for all users other than the
Administrator. Assign access levels in School Setup, Passwords menu.

To define Custom tabs, use the Custom Tab Designer in the Tabs menu in
School Setup.

Multi-Data Tab (Teachers)

Optional. The information in this tab is used only for custom reports.

In addition to User-Defined and Custom tabs, you can define a Multi-Data
tab containing fields, codes, and lists.

You can define up to 2 titles or headings for the Multi-Data tab. Use the
VCR buttons to switch headings.

Only the defined headings appear. If you do not define anything for the
Multi-Data tab, the Multi-Data tab does not appear.

The default access level for Multi-Data tabs is None for all users other than
the Administrator. Assign access levels in School Setup, Passwords menu.

To define the Multi-Data tab, use the Multi-Data Tab Designer in the Tabs
menu in School Setup.

Assigning Teachers

Cloning Teachers

After entering teacher details, you can assign teachers to teach consecutive
periods or teach as a team. Do this in the Teachers view of the Main
window.

Scheduler matches 1 period with 1 teacher in 1 room teaching 1 class. If
you need to schedule a teacher for more than 1 class in the same period, you
need to ‘clone’ the teacher. For example, if 2 classes of PE 11 meet in the
Gym for Period 2, clone the teacher.
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In the Main window, a diamond symbol identifies a cloned teacher.

2 Cavein, Tich A,

3 Dean, Baob

ah Cean, Bob )
A Mt Haivrich

For 1 teacher to teach 2 classes at once, or 2 teachers to teach in the same
room at the same time, use Resource Mapping in the Scheduler module. See
the Scheduler Guide for more information.

You can also clone a room to schedule more than 1 class in the same room
at the same time. See Clone Room in the School Setup Guide.

To create a teacher clone:

1 Highlight a teacher in the Main window.

2 From the File menu, choose Clone Teacher, then click Yes. A dialog
for the cloned teacher appears.

3 In the Personal tab, change Employee Number and Teacher Number.
We recommend you add a letter to the number to indicate a cloned
teacher.

4 You can change the teacher Name. We recommend you add a number
or letter to the name.

The actual teacher name is displayed in the “Teacher is Clone of” field.
In Scheduler, you will see both the actual and cloned names, but only
the actual name will print on timetables and reports.

5 Click the Scheduler tab, then set up the Courses and Rooms for the
cloned teacher. See “Scheduler Tab” on page 39.

6 Click Done.

Setting Up Team Teaching

Create any number of teaching teams, and include a teacher on any number
of teams. Teaching teams are groups of teachers that teach clustered
students. Scheduler uses teaching teams to schedule classes that use student
clusters.
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Team Teaching m

[b Academic 10 |
Teacher Team 2 Teachers

;I I S _lIA Arness, James Al
tdarm, bay

Dean, Bob

Dactar, Heinrich
Diomoney, Dennis
Duchesne, Yanick
Harrizon, John Patrick
tann, Peter Jozeph
Marcos, Imelda
kdarm, Mayp

Masmpth, Patricia
O'Reilly, Janet
Fickle, Shary
Rebak, Davey
‘wilzon, Brenda Jean
‘oo, Fita

>

NewTeamI Delete Team| Cancel Done

To set up a new team:

1 In the Teachers view of the Main window, choose Team Teaching from
the Details menu.

2 If you are setting up the first team, in the Teachers list, double-click all
the teachers belonging to the team.

If the left side displays names, click the horizontal scroll bar to see each
team.

If you are setting up other teams, click New Team, then repeat this
procedure.

3 From the popup menu in the upper left corner, select the program or
grade that this team will teach.
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Entering Student Details

Overview

Enroliment Tab

All schools must enter student records in Details.

The Enrollment, Personal, and Groups tabs display some of the same
information. If entered in 1 tab, shared information automatically appears in
the other tabs.

You must enter the surname and student number before you save student
information.

This tab contains information about the student’s enrollment in the school.
Student pictures can be included, but are optional.

Allsop. Susan Francine m
Health Care Provider “wiork Experience Memberships | Program/5 ervice |

Enrallment | Perzonal | Contacts | Groups | Codes | Health | Mizc. | Cond. | Uzer-Def. | ulti-Data |
[gg] Allsep, Susan Francine Grade Level: 12

Student Mo. 100300

Surname Allzop

First Name Suzan

Middle Mame Francine

Preferred Suzan

Gender b Female

Phone Mo. 1(504] 714-E068 ]

Social Sec. Mum. 1705-49-552

Grade Level B2

Homeroom Number P 102

Track B MAS

Home School B Chanhcery Academy

Birthdate 03 APR &3

Birthplace “emon, France

First Entry Date 03 OCT 92

Al te Student #

Delete Picture Load Picture Cancel Done

Student No.

Also appears in the Personal tab. Student numbers must be unique. The first
unused number that is higher than the last number entered is automatically
entered. You can change this number.

Student numbers are defined in School Setup as numeric, alphabetic, or
alphanumeric.
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Surname, First Name, Middle Name, Preferred

Also appears in the Personal tab. Leave the Preferred name blank if the
student uses his or her first name.

Phone No.

Also appears in the Personal tab. Type the home phone number. Area code
and extension numbers are optional.

Click the letter following the phone number and type L or U for listed or
unlisted.

Grade Level

Also appears in the Personal tab. Scheduler uses Grades and programs to
determine which courses are required for each student and which courses
should be requested for each student by Assign Requests. In both cases, a
match in the student and course’s program and grade is required.

Scheduler uses grades and programs to generate course requests
automatically.

Homeroom Number

Also appears in the Personal tab. Homerooms can also be assigned in
Scheduler.

The homeroom number is independent of any Homeroom course you
schedule. If you need to schedule a homeroom course in Scheduler, assign
homerooms first. Then, in Scheduler, use those homeroom lists to
multi-paste students into their homeroom classes.

You can sort students by Homeroom in Details or for taking daily
attendance in the Attendance module.

Track

Also appears in the Groups tab. Choose a track if your school is year-round
or uses the Track for another purpose. Most year-round schools make an
effort to place siblings in the same track, to accommodate family holidays.
Students can be sorted by track.

Home School

Also appears in the Personal tab. For students from other schools who
attend your school part-time, select the home school for the student.
Schools in this list are entered in School Setup, in the School Names menu.
Students can be sorted by School Name in the Main window of Details.
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First Entry Date

Also appears in the Personal tab. Type the date the student registered, the
date the student record was first entered, or the date the student first
attended your school.

Alternate Student #

Optional. Also appears in the Personal tab. If your district, state, or
province has a number for your student, in addition to the automatic Win
School Student No., type it here.

Loading Student Pictures

Win School stores and displays student pictures. Use a digitizer or scanner
to record pictures as bitmap files (ending with .bmp) and load them into
Win School.

Pictures are loaded and replaced in the same way. If there is an existing
picture, the new picture automatically replaces it.

Picture Unavailable is displayed in the picture window if no picture has
been loaded for a student.

When you create picture files, store them in one folder, and save each
picture file as the student ID number to make sorting easy.

There are 3 ways to load pictures into Win School: using a command, using
drag and drop, or using a control file.

To load a single picture:
1 In the student’s Enrollment tab, click Load Picture.

2 In the dialog that appears, highlight the name of the .bmp file
containing the student’s picture, then click OK.

To load student pictures using drag and drop:
1 Sort your students in the same sort order as your student pictures.

2 Open the folder where the student picture files are stored. If necessary,
sort these files to match the student sort order in Details.

3 Open the first student record in Details, and click the Enrollment tab.

4 Position the Details window so you can see both the student picture
area in the Enrollment tab and the folder with student picture filenames.

5 Drag and drop a picture file onto the student picture area in the
Enrollment tab.

6  Press F4 or click the right arrow button at the top left of the window to
select the next student and repeat the process.
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To load a batch of student pictures using a control file:
1 Create a text file using a text editor such as WordPad.

2 Each student must be on 1 line. Each line must have 2 fields enclosed
by double quotation marks and separated by a comma.

The first field is the student number. The second field is the student’s
picture file name. Press Enter to create a line.

For example:

“114407”,7114407 .bmp”

“171951"”,”171951.bmp”

“328573"”,"”328573 .bmp”

“9299”,79299 .bmp”

“111644”,7111644 .bmp”

3 Save the control file as a text file in the same folder as the picture files.

4  From the File menu in the Details Main window, choose Load Pictures,
then click OK to confirm loading pictures.

5 In the Student Picture Import Control File dialog, highlight your
control file, then click OK.

6  Check the result of your import in the Student Pictures Import window.
If necessary, correct any errors and re-import the batch or import those
pictures individually.

Personal Tab

The Personal tab contains basic information about a student, including
home address, anticipated graduation year, and schools previously attended.

The address format depends on what you selected in School Setup, Student
Address Format menu. The format will be either 2 or 5 address lines.

Student No.

Also appears in the Enrollment tab. Student numbers must be unique. The
first unused number that is higher than the last number entered is
automatically entered. You can change this number.

You set up student numbers the Student Numbers menu in School Setup, as
numeric, alphabetic, or alphanumeric.

Surname, First Name, Middle Name, Preferred

Also appears in the Enrollment tab. Leave the Preferred name blank if the
student uses his or her first name.
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Phone No.
Also appears in the Enrollment tab. Type the home phone number. Area
code and extension numbers are optional.

Click the letter following the phone number and type L or U for listed or
unlisted.

Physical Address/Mailing Address
Use the VCR buttons to toggle between the address where the student is
living and the address to which mail should be sent.

If both addresses are the same, enter a Physical Address only.

Address 1, Address 2, City, State, Zip Code
For 2 Address Lines format.

Address 1 and Address 2: type street address (number, street name, and, if
applicable, apartment number, post office box or rural route number).

Choose the city and state. Type the zip code. Students can be sorted by zip
code.

Phys Addr Num, Phys Addr Street, Phys Addr Type, Phys Addr Dir,
Phys Addr Apt., City, State, Zip Code

For 5 Address Fields format.

Type street number, street name, and, if applicable, apartment number.
Choose address type, address direction, city, and state.

Type the zip code. Students can be sorted by zip code.

Area, County
Optional. Students can be sorted by Area.

Grade Level

Also appears in the Enrollment tab. Grades and programs are used by
Scheduler when determining which courses are required for each student
and which courses should be requested for each student by Assign
Requests. In both cases, a match in the student and course’s program and
grade is required.

Scheduler uses grades and programs to automatically generate course
requests.
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Homeroom Number
Homerooms can also be assigned in Scheduler.

The homeroom number is independent of any Homeroom course you might
schedule.

You can sort students by Homeroom in Details, or in the Attendance
module for taking daily attendance.

Family No. and Family Unit

Optional. Use these fields if you group siblings by family. Give each family
a unique number. Unit letters allow you to create sub-divisions within
separated families. Give each household a different letter.

Some schools assign meanings to the Unit letters. For example, A means
living with both parents, B means living with mother and/or her new
spouse, C means living with father and/or his new spouse, D means living
in foster home, and so on.

If the contact is not part of the immediate family, give the contact a unique
family number or a special number, such as 0 or 999, that is reserved for
contacts not related to any students in the school.

This information can be used for mailings.

First Entry Date

Type the date the student registered, the date the student record was first
entered, or the date the student first attended your school. For reporting
purposes only.

Alternate Student #

Optional. Also appears in the Enrollment tab. If your district, state, or
province has a number for your student, in addition to the automatic
Win School Student No., type it here.

Extended Info 1, Extended Info 2, Comments, Activities
Click the VCR buttons for 4 sets of information:

Grad Year Optional. Type the year that the student is expected to
graduate.

Grad School Optional. Choose the school from which the student will
probably graduate.

Field Trip Perm | Optional. Indicate if the parents have signed a general
release to allow this student to attend field trips.
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Contacts Tab

Birth Cert.

Optional. Indicate if school staff have verified birth
certificate information.

Home School

For students from other schools attending your school
part-time, select their permanent school. Schools in this list
are entered in the School Names menu in School Setup.
Students can be sorted by School Name in the Main
window of Details.

Original Name

Optional. If the student name has changed, type the
original name.

TAG Date Optional. Type the date the student was identified as
Talented and Gifted.

TAG School Optional. Select the school that first identified the student
as Talented and Gifted.

Comments Optional. Scrolling text field to type comments about the
student.

Activities Optional. Scrolling text field to describe student activities.

Type up to 6 contacts for the student. This information is for the Query
module and reporting purposes only. Built-in reports in the Attendance
module include only Contacts 1 and 2.

Allsop. Susan Francine m

Special Training | Parent Fosting Histary Special Teams E ducation Higtory I
Enroliment | Perzonal Contacts | Groups | Codes I Health | hisc. | Cond. I User-Dief. I
’gg] Allsop, Susan Francing Grads Laval: 12
First Contact
“ I [
Title # Ms. Employer ABC Photography
Surname &llzop Type AN
First Hame Frances Position Retail Clerk.
Middle Hame E ducation
Relation # Mother Work Address 1
Custody b e Work Address 2
Mailings b Yes Wwork City # Surrey
Family No. 0 Work State #Ch
Family Unit BN Work Zip Code 93056
Address 1 22 Highhand Drive Social Sec. Hum. 434565787
Address 2 FA Humber _L)ETRRFFT [
City # Bumaby Work Phone L Jd43nRSEE O]
State #BC
Zip Code 93766 Home Languages # English
Home Phone 1 [604) 714-6062 400311 Tranglation B Mo
Student Lives With | Parents ‘ ‘ Address Control B Unique ‘
Debtor B M
Cancel | Done |
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Specific contacts can be reserved for specific information. For example, the
mother can always be the First Contact and father can always be the Second
Contact.

The VCR buttons at the top of the tab control which contact information is
displayed. A checkmark identifies the information currently displayed.

+ First Contact
Second Contact
Third Contact
Fourth Contact
Emergency Contact 1
Emergency Contact 2

The Student Lives With and Debtor fields at the bottom of the tab are for
the student and remain unchanged for each contact.

Address Control
At the bottom of the Contacts tab, select address control for each contact.

A contact address can be unique, or it can be copied from an existing
address. The Address Control popup menu in the lower right corner of the
tab controls the source of the address information for the currently-
displayed contact.

The Address Control menu is different for each contact.
If a contact address is unique, all data fields are editable.

If the address is copied from another source, Address 1, Address 2, City,
State, Zip Code, and Home Phone are not editable. The padlock to the left
of those fields indicates that they are locked. When the source address is
changed, these fields are updated automatically.

If you change Address Control to another source, the content of address
fields changes to the new source address. If you change to Unique, the data
remains unchanged, but it becomes editable. If you change from Unique to
a source, the content of the address fields is replaced by the source data.

Student Lives With

Optional. Type up to 21 characters for the person with whom the student
lives. This information is for reporting purposes only and is not correlated
to Family Numbers or Unit letters.

Debtor
Select the contact to be billed for expenses incurred by this student.
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Groups Tab

Family No. and Family Unit
Optional. To group siblings by family.

Give each family a unique number. Unit letters allow you to create sub-
divisions within separated families. Give each household a different letter.

Some schools assign meanings to the Unit letters. For example, A means
living with both parents, B means living with mother and/or her new
spouse, C means living with father and/or his new spouse, D means living
in foster home, and so on.

If the contact is not part of the immediate family, give the contact a unique
family number or a special number (such as 0 or 999) that is reserved for
contacts not related to any students in the school.

This information can be used for mailings.

Address 1, Address 2, City, State, Zip Code and Home Phone

If Unique is selected in the Address Control menu, these fields are editable.
Type the contact street address and home phone number. If Unique is not
selected, these fields are not editable, and a padlock appears to the left of
each of these fields to indicate that they are locked.

Employer, Education, and Translation

Type the contact’s employer, highest level of education, and whether a
translator is necessary to communicate with this contact.

This tab contains information about groups to which the student belongs,
the user-defined lists, and the student counselor and program fields.

Normal Program

Choose the normal program for the student, if applicable. The normal
program for this student is used by Scheduler to determine the courses
required for the student and the number of credits required by the student
program.

Special Program

Choose the special program for the student, if applicable. Special Program
is used by Scheduler to determine the courses required for the student, and
by Assign Required to assign requests.
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Ethnic Categories, Home Languages, Lunch Status, User Defined
Lists

Choose the applicable information for the student in each of these popup
menus. Titles of these lists can be changed in School Setup.

Students can be viewed by Ethnic Category in the Main window and sorted
by Ethnic Categories in the Sort dialog.

Track

Choose a track if your school is a year-round school or uses Track for
another purpose. Most year-round schools make an effort to place siblings
on the same track to accommodate family holidays. Students can be sorted
by track.

Groups and Their Dates
Record the groups this student does or did belong to.

If another user is editing this student’s group, a padlock icon appears in the
Groups tab until that user closes.

Attendance can display students by group to allow you to enter data or print
reports for all group members at once.

To record group membership for this student:

1 Click New Group. A new group appears at the end of the list.

2 Choose the group name from the popup menu, then type the start and
end date of the student’s membership in that group.

3 To enter N/A as a date, highlight the month and press Backspace.
4 To delete a group, highlight the group name, then click Delete Group.

Use this tab to record student status codes, which track student registrations
in and withdrawals from your school. Status codes are needed to accurately
track attendance. This tab also stores user-defined codes for reporting
purposes only. Use the VCR buttons to display Status Codes or User
Defined Codes.
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Abrosimoff, Martin Frederici m
Enrallment I Perzonal | Contacts | Groups Codes | Health I Mizec. | Cond. | Uszer-Def. I
[gg] Abrosimoff, Martin Frederici Grade Level: 11
# Status Codes Date I Status Code Comment
44 113
b Ervolled Dec 09, 53 Ll
2 b Left Jun 20, 95
3 b Returned Jan 20, 96
w
Delete Code New Code Cancel Done

Status Codes

You create status codes in School Setup and use them to track student
enrollment status by recording school entry, withdrawal, and re-entry. An
Active student is currently enrolled in the school. An Inactive student is not
currently enrolled; either the student has withdrawn or the student entry
date has not yet arrived.

The first status code is the first Entry code for this student. If the student
status changes, record that change as a new status code.

Before year end, give graduating students a Withdrawal status code to make
them inactive. In student lists, the record will be in italics. Don’t delete
graduated students in your current year database. Delete them in your next
year database.

You can hide inactive students by choosing Hide Inactive Students from the
Edit menu.

In the School menu in School Setup, the option you selected in the
Withdrawal Inactive Day menu determines whether the students become
inactive on the date of a Withdrawal code or on the day after the date of the
Withdrawal code.

Students become active on the date of an Entry or Re-Entry code. The Re-
Entry or Entry code date must be at least 1 day after the Withdrawal code
date.

The Attendance module checks each current enrollment status to determine
whether to set the student default daily attendance code to Present or Not
Enrolled. If you change a student status code in Details, the student
attendance codes are automatically updated in the Attendance module.
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To create a Status Code:

1 Click New Code to add a new code to the end of the list.

2 From the popup menu, choose the status code.

3 Type the date the code takes effect and any comments you have.

Status code dates must be school days. If they are weekends, holidays,
or days outside of your school terms, they are omitted from Attendance
and state reports that show status codes.

User Defined Codes

Use these codes to track something such as student citizenship or at-risk
status, where the student has only 1 status at a time. Set up User-defined
Codes in School Setup, in the Student - User Defined menu.

Click the VCR buttons to display other user-defined codes.

To enter a new User Defined Code:

1 Click New Code. A new code is added to the end of the list.

2 Choose the user-defined code from the popup menu.

3 Type the date the code takes effect and any comments you have.

User-defined code dates must be school days. If they are weekends,
holidays, or days outside of your school terms, they are omitted from
Attendance and state reports that show user-defined codes.

Health Tab

Use the Health tab to track student emergency information such as doctor
name and phone number, medical conditions, or alerts.

Call Doctor and Call Ambulance

Indicate parental permission to call the doctor or ambulance directly and/or
parental agreement to pay for any charges incurred by calling the doctor or
ambulance.

Immunized

Useful for an inoculation campaign.

Choose No for all students, then as inoculation is administered, change to
Yes.

Can treat

Indicate whether the parents have signed a waiver allowing the school to
treat the student.
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Miscellaneous Tab

Conduct Tab

Medical Comments

Type any comments about the student’s medical history that the school
should know or be able to give to medical authorities. The field scrolls to
allow large text entries.

Medical Alert

Type any medical information that the school should know or be able to
give to medical authorities.

Information on this tab is used by some state and provincial attendance
reports.

User Defined Flags

Choose Yes or No for these flags which you defined in School Setup,
Student - User Defined tab.

Transportation

Type transportation information in these fields which you defined in School
Setup, Student - General, Transportation.

Legal Alert

Type any legal information. Some schools use this field for a password
from parents to give to others who are sent to pick up a child.

Student conduct can be infractions that need disciplinary action or
outstanding behavior that is rewarded. Information in this tab is for
reporting purposes only with the exception of suspensions. Suspension
information is passed to Attendance to be automatically recorded.

The Conduct tab has 2 views:
e The Summary view lists all the conduct records in chronological order.

e The Details view shows the details of 1 incident, including conduct
comments. Use the horizontal scroll bar to see different incidents.
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To enter a new conduct incident:
1 In either view of the tab, click New Conduct.

2 Add or edit conduct code information.

To delete a conduct incident:

1 Display the conduct record in the Details view of the tab or click it to
select its number in the Summary view.

2 Click Delete Conduct.

Action, Action Dates

Choose the action taken in response to an incident, and type its start and
finish dates. The default dates are N/A. To replace a date with N/A,
highlight the month field and press Backspace.

Attendance requires start and end dates for suspensions. For a 1 day action,
type the same date in both fields.

Print Conduct Report

A conduct report, which can be sent home to parents, can be printed from
the Conduct Tab. Each report is complete with spaces for signatures and
special comments, and allows for a message for parents.

To print a conduct report:

1 Select the incident you want to print on this report.

2 Click Print.

3 Type your message (up to 255 characters) or leave blank. Click OK.

4 To send the report to the printer, choose Print from the System menu,
which you access by clicking the icon to the left of the window title.

£

= Conduct Report

i
”"' ‘ Completed 1003
System menu

Save As

Eestare

bdove

Size 1D#

et 1234557

binimize

haximize

Close Alt+F4 "
Location:
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User-Def. Tab

All user-defined fields from the School Setup module appear in this tab.
You cannot select or edit any field that is locked in School Setup. A
padlock appears in the left of any locked field. Most text fields can contain
15 characters. Some fields can contain 49 characters.

Custom Tabs (Students)

Optional. The information in these tabs is only used for custom reports.

In addition to the data in the User-Defined tab, you can define up to 10
Custom tabs containing fields, codes, and lists.

Custom tabs appear in their own row. Only the defined tabs appear.

The default access level for Custom tabs is None for all users other than the
Administrator. Assign access levels in School Setup, Passwords menu.

To define Custom tabs, use the Custom Tab Designer in the Tabs menu in
School Setup.

Multi-Data Tab (Students)

Optional. The information in this tab is used only for custom reports.

In addition to User-Defined and Custom tabs, you can define a Multi-Data
tab containing fields, codes, and lists.

You can define up to 5 titles or headings for the Multi-Data tab. Use the
VCR buttons to switch headings. Only the defined headings appear.

The default access level for Multi-Data tabs is None for all users other than
the Administrator. Assign access levels in School Setup, Passwords menu.

To define the Multi-Data tab, use the Multi-Data Tab Designer in the Tabs
menu in School Setup.

Entering Student Details o User-Def. Tab 59



Win School Details

Entering Resources Details

Overview

Resource Tab

Use Resources Details to track course resources, such as the books or
special materials needed for a course, and their costs.

Create items for the popup lists in the Resource Types dialog in School
Setup Details Lists menu.

After you set up resources in the Resources view in Details, you can assign
resources to each course in Course Details in the Lists tab.

You can create booklists for courses or for individual students in Report
Manager.

Enter up to 20 resources per course, to a maximum of 1000 resources in
your database.

Enter all of the resources used at your school that you want to track in
Win School.

Applied Math B

Fesource
Applied Math
Mumber 100020 |
Title Aipplied ath
Edition 12th
Type # Textbook Comments
Grade Level I Senior o
Subject Area # Mathematics
Unit Price 55.00
Page Count 0
Author Surname Derbez
Author First Mame Eric
Author Middle Hame
Publisher # Prentice Hall
Publizher City # Your town
Publizhed Date A
ISBM
LCCN
Location FAES i
Cancel Done
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Number

Type a reference number for the resource.

Title
Required. Type a resource title. Titles should be unique.

Edition

Type the edition number of the resource.

Type
Choose a type of resource. Create the list in the Resource Types dialog in
School Setup Details Lists menu.

Grade Level

Choose the grade level for which this resource will be used.

Subject Area
Choose a subject area.

Unit Price

Type the unit price of the resource.

Page Count

Optional. Type the number of pages for a book or some other amount
indicating size of the resource.

Author
Type the resource’s author in the format: surname, middle name, first name.

Publisher

Choose a publisher name. Create the list in the Publishers dialog in School
Setup Details Lists menu.

Publisher City
Choose the city in which the resource was published.
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Publisher Date
Type the date of publication.

ISBN
Optional. Type the International Standard Book Number.

LCCN
Optional. Type Library of Congress Cataloging Number.

Location

Choose the location where this resource is available. Create items for the
popup list in the Resource Locations dialog in School Setup Details Lists.

Comments

Type comments about the resource.
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Working With Reports

Overview

From the Details Main window, you can customize and print 3 built-in
reports, and develop your own custom reports.

Printing Reports on Paper

Choose a report from the Reports menu, specify what you want in the
report, then click Print. The report is displayed in a window.

To send the report to the printer:
e  From the System menu, choose Print.

The System menu is the icon to the left of the window title.

Course Selected Items Report

The Course Selected Items report prints selected information about selected
courses.

Print and review this report before using the Scheduler module, to make
sure that your data is entered correctly.

To print the report:
1  Choose courses in the Courses Main window.
2 From the Reports menu, choose Course Selected Items.

3 In the dialog that appears, select the fields you want to print on the
report. Click Print.

Student Conduct Report

Use this report to track conduct trends. Some of the reports you can print
are:

e A complete report for individual students.
e All conduct incidents handled by a particular staff member.

e All suspensions, or any infraction or action, within a date range.

Working With Reports e Overview 63



Win School Details

All students with more than a minimum number of suspensions, or any
other infraction or infraction action.

All students with a particular infraction.

To print the report:

1
2
3

Choose students in the Students view of the Main window.
From the Reports menu, choose Student Conduct.
Select options.

Select Summary Only if you want only a summary of the selected
incidents.

Click Print to display the report.

To send the report to the printer, choose Print from the System menu,
which you access by clicking the icon left of the window title.

Homeroom Roster Report

Use this report to see if students and teachers are correctly assigned to
homerooms, and to list students by their homerooms.

The report lists the students in selected homerooms, with space for teachers
to record attendance, marks, or any other information.

Each homeroom is printed on a separate page. Within each homeroom,
students appear in the order defined in the Sort dialog.

To print the report:

1

In the Students view of the Main window, choose Homeroom Roster
from the Reports menu.

Select the homerooms you want listed.
Choose the Report Format you want by clicking an image.

Choose from Items to Print. Select Student name or Student number to
make the Print button active.

Click Print to display the report.

To send the report to the printer, choose Print from the System menu,
which you access by clicking the icon left of the window title.
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Student Transfers Report

Custom Templates

This report lists the dates of selected students’ transfers between normal
programs, homerooms, grades, and tracks.

All transfers for a student print together. To print a separate page for each
type of transfer, print from the Transfer Editor dialog. See “Recording
Transfers in Student Records” on page 19.

To print the report:

1  Choose students in the Students view of the Main window.

2 From the Reports menu, choose Student Transfers.

Print reports using custom templates created in Report Manager.

Use this option if you have Report Manager templates available for Details.
Use custom templates to report on information from other modules, or
information not included in one of the predefined reports.

To print the report:

1 Ifrequired for the report, select the students, teachers, or courses
needed in the Main window.

2 From the Reports menu, choose Custom Templates.

3 Choose a template. The list is empty if no templates are available for
Details.

4 If you want to use the Filters dialog to constrain the report, choose Use
Report Options.

5  Click Print.

If the Filters dialog opens, choose the filters for the report and click
Print to display the report. For more information on filters, see the
Report Manager Guide.

6 To send the report to the printer, choose Print from the System menu,
which you access by clicking the icon left of the window title.
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Troubleshooting

Can’t move a student from the archive file back into my database

Not available yet. We recommend that you keep withdrawn students in your
active database for a year or more, so that they are available if you need to
reactivate them.

Can’t select popup list item with mouse
If you are running MS-Office 4.2 or HP Jet Direct in the background, you
might encounter this problem.

Exit MS-Office or HP Jet Direct, or use the keyboard to make your
selection. For example: in Select/Replace/Assign, to change the Bin to Bin
4, click the popup list and type 4 rather than using your mouse.

Changing Information

Can’t add a new course in Course Details

Ask the System Administrator to set the Access Level to Edit for Resources
in Course Details. In School Setup, Passwords, System Passwords, change
the Access Level to Edit for Details - Resources for user IDs that have edit
access to Course Details.

The Main Student window doesn’t show homeroom change but Enroliment tab does

In School Setup, Transfer Recording is on. Changes to student homeroom,
grade level, normal program, and track will take effect the following day.

To make the change immediately:

1 In Student Details, highlight a student and choose Transfer Editor from
the Edit menu.

2 Change the date of the transfer to the previous day’s date.
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Can’t Change Course Information

O—3]

If you are unable to change course information in the Periods or Scheduler
tab, the course is already scheduled or has sections already scheduled.

Before this information can be changed in Course Details, remove
scheduling for the classes and delete all the sections.

If you remove a student from a section, all the marks for the student in that class
might be deleted.

To remove a class from the school timetable, and delete sections:
1 Open the Scheduler module.

2 From the Windows menu, choose School Timetable.

3 Double-click the class in the Class Name section.

4 Highlight the sections in the Class Timetable at the bottom of the
screen, then press Delete.

5 Return to Details and change the course information.

Can’t Sort Students After Changing Student Grade Levels

Deleting

Deleting courses

In most cases, nothing is wrong. Win School was designed to ensure that
attendance data remains correct. Any changes made to student information
using Select/Replace/Assign are not registered until the following day. This
safeguard is to ensure the student does not receive attendance for both
homerooms.

If you receive the message: “Some records weren’t deleted because they
had other references or were currently locked by another user,” it means
this course has been assigned somewhere in the program. Remove the
course from Linked Groups, Teacher Preferences, School Timetable, Set
Sections window, and Student Request files.
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Deleting student records

If you receive the message: “Some records weren’t deleted because they
had other references or were currently locked by another user,” it means a
student has course requests and/or timetables in Scheduler. As you cannot
delete student records which have requests or timetables, first delete those,
then delete the student record.

To delete student requests and timetables:

1 In Scheduler, select student record(s).

Use Set Preferences in the Edit menu to Show Inactive Students if you
want to select their records. This is different from “Hide Inactive
Students” in the Edit menu in Details.

2 From the Schedule menu, choose Change Student.

3 In the Change Student dialog, select Clear Requests, Clear Alternates,
or Clear Timetables.

4  Click Perform.

Linked Groups and Following Triplets disappear after entry

Either a flag, a following triplet, or linked group has been changed.

If the “All sections in the same block™ flag on a course has been changed,
change the flag back to its original value. This procedure ensures classes
show in Linked Groups and Following Triplets.

To change the All sections in the same block flag:

1 In the Courses view of the Main window, double-click the course
name.

2 Click the Periods tab and change the “All sections in the same block”
flag to its original value.

3 Click Done.

If a course belonging to a Linked Group or Following Triplets has been
deleted, re-enter Linked Groups and Following Triplets. To avoid this
problem, do not delete a course belonging to a Linked Group or Following
Triplet.
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Scheduling Teacher Type, 41 Students, 46, 54
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